
The results from applying statistical technology 
software into classroom in comparison against the 

 by hand 
 

Komm Pechinthorn 
 

Marketing Department, International College, Rajamangala University of Technology Krungthep 
2 Nang Linchi Road, Thung Maha Mek, Sathorn, Bangkok, Thailand 10120 

*Corresponding author. Tel: 66 2287 9600, Email: komm.p@mail.rmutk.ac.th
 

ABSTRACT 
The purpose of this research was to find out whether or not technology which has 

impact on the student's motivation, interested way of learning, understanding, ability to 
apply after graduation, effectiveness and should be applied again in the statistic subject. 
Our procedure involved the completion of one real classroom over the course of 15 weeks 
study. The entire class was designed to learn by the traditional way along with the computer-
based statistical software to calculate the complicated numbers in statistics subject in order to 
compare the differences. Likert scale questionnaire and before-after-statistical test were used 
as tools to collect and analyze the data respectively. In addition, in-depth interview was also 
included to ensure the quality of quantitative findings. Results of this research indicated 
the idea that when applying technology into classroom at university level, students 
evidently and strongly prefer the technology rather than the traditional method where 
calculations take long time and are done by hand on the board. 
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1. INTRODUTION 

Technology is now the forefront of 
the modern world to create new jobs, 
innovations, and networking sites to allow 
individuals to connect globally. Computer 
software and Internet are among the fastest 
growing and most important in education 
nowadays [1]. Evidently, companies accept 
and hire employees from online graduates 
to work for them not only from the 
traditional curriculum universities. This is a 
strong indication that students can benefit 
from technology learning process [2]. 
Undoubtedly, the educational leaders and 
policy makers are having difficulty 
managing the young students and preparing 
them for the 21st century. Innovative use of 
modern technology is one way to improve 

the vision of schooling [3]. Hence, an 
attempt to introduce the technology into 
classroom and to measure the effectiveness 
might be worthwhile and could alleviate the 
difficulties for educational policy makers in 
Higher Education.  

There is strong evidence indicating 
for using technology leading to higher score 
of standardized tests [4], nonetheless the 
noticeable emphasis should not be limited 
on the test score of that specific course. 
Instead, how to increase their motivation, 
enable those who cannot perform in 
traditional classes, make them more 
positive toward education with new 
technology should be carefully discussed 
by educational researchers [4]. There has 
been research finding that classroom is the 
place where students spend their learning 
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times. Generally, students feel bored and 
have less contributions in traditional 
classroom without technology support.  
Teachers are not able to motivate the 
students. Therefore, it is a huge barrier to 
increase the quality of education [5].  

Therefore, this research has been 
formed to reveal and answer questions to 
those challenges by testing in statistics class 
in International College of Rajamangala 
University of Technology Krungthep 
(ICRMUTK), a public university located 
in the central of Bangkok, Thailand. 
Traditional calculation by hand from 
mathematicians and university teachers on 
the board is the traditional way in class 
making students feel highly complicated 
and extremely bored. It also makes students 
who are not smart in mathematic often feel 
discouraged, lose focus and try to pass 
with minimum effort. In addition, the 
expected beneficiaries of this research 
are teachers who recognize themselves 
as furthering the improvement of the 
classroom and eliminating complications 
and boredom in statistic and related classes.  

1.1 Literature Review 
Educational results were identified

in Pittsburgh, Iowa where an algebra 
curriculum that combined the traditional 
approach with the use of technological 
computer tools. Koedinger et al. [6] found 
that there was a 15% increased score                 
on the Iowa Algebra Aptitude Test, which 
was significantly higher than the 
comparison group without such tools. 
Angrist and Lavy [7] presented a similar 
research finding that not only technology 
improve accomplishment on 
test scores, it also increases their GPA 
eventually. The empirical research finding 
show that technology integration in 
teaching field is encouraged for many 
reasons which include academic ability 
improvement, more engagement and better 
collaborative learning enhancement [8]. 

Furthermore, Morgan and Ritter [9] 
conducted an educational research on 
technology with Mathematics subjects in 
Oklahoma, United States. By choosing 
many ethnicities and both sexes to represent 
the data, they discovered the students in 
computer-based curriculum outscored the 
students registered for the traditional math 
curriculum in 5 of the junior high school 
within the testing area. Moreover, Harandi 
[10] strengthens the use of new technology, 
for instance, websites, computers, internet and 
electronic media in classroom and shows 
the results lead to successful learning 
process for students in university level. 
Technology does not limit itself into 
helping educational industry. In medical 
industry, it is also used in various fields to 
help people disabilities. One medical study 
found that reading disorder called Dyslexia 
prevents students to read quickly, spell and 
pronouncing words correctly can be improved 
significantly by using the computer remediation 
program. The score is much higher and rises 
above the normal range [11]. Even for 
country that is considered behind inInformation 
technology, it is a powerful tool for the 
development of quality and must be ensured 
for maximized use in teaching and learning 
system [12].       

Despite those successful in applying 
technology to students, many research 
findings said otherwise. Funkhouser [13] 
argues that some studies did not find 
significant differences in motivation, 
student attitude and improvement towards 
using technology even though most of              
the researches usually back up the correlation
of improved attitude with applying
technology in class. As one research
concluded, Norton et al. [14] disagree with 
the claim that simply using technology 
or putting computers in the classroom is
likely to lead the students to such positive 
changes in learning outcome. In fact, it 
would depend on many uncontrollable
internal and external factors. Although
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the students gain many benefits of using
technologies, downloadable class materials,
instant messaging, lack of engagements,
technological cheating opportunities and 
the social network are considered the 
disruptions in classroom [15]. Lack of access, 
lack of effective training, attitude, 
and attitude were identified as 
barriers to hinder the use of technology 
[16]. Meanwhile, Younes and Al-Zoubi 
[17] conducted a research on exploration 
of pros and cons of the internet network 
which include several part of exchanging 
information,entertainmentandcommunication. 
Apparently, over 90% of the respondents 
have strong desire to use the internet. 
However, their finding revealed the 
negative impacts on using internet such as 
ethical, social and health problems when 
overconsuming. Moreover, Younes and 
Al-Zoubi [17] point out that the value of 
oriented family interaction was eroded by 
negative impact of media and technology. 
Therefore, applying statistical technology 
software must be implemented in class 
with prudent consideration.  

 
2.METHODOLOGY 

2.1 Research Population and Data Collection 

The 4th year undergraduate students 
in ICRMUTK with the total of 37 are 
the research populations. There are 17 male 
and 20 female students with the age range 
of 22 to 25 years old who already have 
some knowledge about statistic from 
hand-calculated General Mathematics and 
Quantitative Analysis subjects throughout 
the first three years of the university. They 
were approached by the researcher inside 
the classroom since week 1 given the 15 
weeks long in one semester. International 
Business Research is a required class as                   
a core subject for the students in the last 
year prior to graduation which includes  

many types of complex hand calculations. 
Therefore, this research selected and tested 
in International Business Research subject.  

To actively approach the students 
who were used as samples, clear explanation 
and instructions by the researcher were 
informed repeatedly about the goal and 
benefit of this research since week 2 and 
later on. After week 15, the researcher asked 
them to complete the questionnaires by 
comparing the hand calculation against 
the applying the technology of statistical
software. To assure the most accurate data, 
the questionnaires have been screened by 
the researcher and 2 assistants to avoid simple 
mistakes. In addition, qualitative data were 
obtained from in-depth interview from 
some students.    

Prior to commencing the testing, the 
researchers determined the significant level
at 0.05. The 5-point Likert-type scale has been
put in the questionnaires to make it applicable
for respondents when filling the information. 
The range of score from the respondents is 
1 to 5 with indication of strongly disagree
to strongly agree respectively with 3 as 
neutral in order to ensure the accuracy and 
standard when data collecting. 

2.2 Actual classroom procedures 

Multiple functions in statistical 
software namely SPSS, Excel and Minitab.
are calculated and shown on the board to the 
37 students as shown in Table 1. Due to the 
fact that each software does not have all 
calculation functions to cover different types 
of statistical knowledge, the researcher applies 
2 software to make the class as effective as 
possible 

Meanwhile, the class usually starts with 
hand calculation before applying statistical 
technology software. For that reason, the
students perceive the sense of comparison
throughout the semester  
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Table 1. Completed details of function buttons demonstrated in real classroom 
 

Statistical 
software 
program 

Direction: Click the buttons below in order objective 

SPSS 
Analyze=> Descriptive 

Statistics => Explore Normality of the data 

Analyze=> Compare 
Means=> One Sample T-test Significant level of 

data 

Excel Data=> Data Analysis => 
Anova: 

Single Factor or 
Anova: Two Factor 

Analysis of variance 
of data with single 

and two factors 

 
Minitab 

 

Stat=> Basic Statistics 
=> Normality Test Normality of the data 

Stat=> Nonparametric=> 1-Sample Sign Significant level of 
data 

Stat=> Regression=> Fit Regression 
Model 

Significant level data 
with regression 

model 
 

2.3 Research Hypothesis 

To measure the internal consistency 
for Likert-type data collected, Cronbach's 
Alpha will be tested to check the reliability 
before further analyzing data.  

The hypothesis of the normality of the 
collected data 

Two separate hypotheses are presented
below for this research. Secondly, the
normality test of the collected data will be 
tested to find out whether or not they are 
normally distributed in order to select the 
most accurate statistical running software. 
The Kolmogorov-Smirnov test by Minitab 
is applied for this hypothesis.  

H0: the collected data from this class has 
normal distribution 

H1: the collected data from this class does 
not have normal distribution 

 

 

The hypothesis of positive implication 

Last, the attempt to test positive 
implication by using Before (traditional 
hand calculation method) against After 
(usingstatistical software/ technologyapplication
in the subject). The hypothesis is seeking 
the result for testing in six different 
categories including motivation, interesting 
way of learning, understanding, ability to 
apply after graduation, effectiveness and 
technology continuation in the statistic 
subject.  

H0: After applying Technology in class, it 
does not have positive impacts to the 
students than before. 

H1: After applying Technology in class, it 
has positive impacts to the students than 
Before. 
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RESULTS AND DISCUSSION  

Table 2  Reliability Statistics by SPSS 

Cronbach's 
Alpha 0.857 

Number of Items 6 

Item-Total Statistics 
 

Category 
of Testing 

Scale 
mean if 

item 
deleted 

Cronbach's 
Alpha if 

item 
deleted 

Motivation (Q1) 5.6757 0.854 

Interesting way of 
learning (Q2) 

5.5135 0.818 

Understanding 
(Q3) 

6.2162 0.842 

Ability to apply after 
graduation (Q4) 

5.4865 0.849 

Effectiveness (Q5) 5.5135 0.814 
Technology 

continuation (Q6) 
5.7838 0.821 

The Cronbach's Alpha scores from 
question 1 to 6 from Table 2 above are all 
high with the lowest score of 0.814. It can 
be anticipated that the data has acceptable 
reliability since the reliability coefficient 
of 0.70 or higher is considered to be 
qualified in most researches.  

Table 3  Tests of Normality of Collected 
Data by SPSS 

Category  
of Testing 

Kolmogorov-Smirnov 
Statistic N Significant 

Level 

Q1 0.184 37 0.003 

Q2 0.199 37 0.001 

Q3 0.183 37 0.003 

Q4 0.178 37 0.004 

Q5 0.216 37 0.000 

Q6 0.199 37 0.001 

Before running the data by using 
statistical software of Minitab, the raw data 
is required to test their normality in order 
to have the most accurate research finding. 
As presented in Table 3, the numbers of               
P-value or significant level are all less than 
0.05 and stay near 0.00 which reject                  
the hypothesis. These indicate the data 
collected from the questionnaires is not 
normally distributed. Therefore, statistic 
function such as One Sample T-test from 
SPSS is ignored, and the nonparametric             
1-sample Sign Test from Minitab software 
is chosen.   

Table 4: Descriptive statistics by Minitab 
software version 18 

Sample N Mean Standard 
Deviation 

Std. Error 
Mean 

Q1 37 1.1622 1.40463 .23092 
Q2 37 1.3243 1.39551 .22942 
Q3 37 0.6216 1.60470 .26381 
Q4 37 1.3514 1.29564 .21300 
Q5 37 1.3243 1.27048 .20887 
Q6 37 1.0541 1.15340 .18962 

Table 5  The nonparametric Sign Test by 
Minitab software version 18 
Sign Test for Median: Q1, Q2, Q3, Q4, Q5, Q6 

 

Null hypothesis H  
 

Alternative hypothesis H
0 

 

Sample Number 
< 0 

Number 
= 0 

Number 
> 0 

P-
Value 

Q1 7 9 21 0.006 
Q2 7 6 24 0.002 
Q3 10 7 20 0.049 
Q4 5 10 22 0.001 
Q5 7 6 24 0.002 
Q6 3 11 23 0.000 
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 After running the data by using 
nonparametric test of Minitab on Table 4, 
the descriptive all 6 questions are 
presented with number of respondents, 
mean, standard deviation and standard 
error. On Table 5, the results tend to be in 
the same direction representing all 
numbers of P-value or significant level at 
less than 0.05. These rejected the 
hypothesis. Therefore, After applying 
Technology in class, it has positive 
impacts to the students than Before. 
However, question 3 presented to P-value 
of 0.049, which is the nearest to not being 
rejected at >0.05. For this question, the 
respondents are doubting whether they 
have better understanding when applying 
technological statistical software in class 
against the calculation by hand. In fact, 
calculation by hand remains the 
fundamental of mathematical and statistic 
subject by most teachers.  
 Overall, the findings in this 
research indicate that applying technology 
in statistic related subject is moving 
toward benefits rather than negative 
which is related to work done by [12]. 
Technology provides the amazing 
potential to deepen skills, accelerate, 
engage and enrich students. 
Furthermore, better school experience, 
strengthening teaching and helping 
positive changes are the result of 
applying technology [12]. The respondents 
apparently demand more technology which 
is associated with the finding of McIntyre et al. [8] 
where they point out the trend of the 
students are quite hungry for greater 
autonomy, independence and technology 
in classroom learning more than they 
commonly receive from teachers.  

-depth interviews,           
it was found that statistical technology 
software such as SPSS, Excel and 
Minitab made students feel more 
motivated, interested and effective 
because it provided the easiness and saved 

substantial amount of time from the 
hand calculation by teachers. Students 
can play on their phones and lose focus 
any moment during class. They realized 
and agree with the fact that once they 
have jobs after graduation, there is a 
possibility to use these statistical 
functions to calculate real data. In fact, 
they cannot do the same with the 
complicated hand calculations. The 
qualitative data reveal clear implication 
about the level of understanding of the 
selected subject in this research. Despite 
the fact that 21st century students are 
likely to take shortcut and prefer the 
easiest way to pass the class, they 
realized and informed the understanding 
of statistic related class must come from 
calculation by hand. From the 
quantitative and qualitative interpretation, 
researchers have to continue the testing 
and investigation on how much value of 
technology to education in the hope of 
significantly outscoring the barriers [18]. 

 
4. CONCLUSIONS 

This group of 4th year student 
prefers using technology in the statistics 
class and demand more technology in the 
future. Undoubtedly, the benefit of using 
technology in teaching the classroom is 
significant and technology itself has 
potential to be a powerful tool in 
education. Nevertheless, there are 
controversies in this topic and By 
evaluating this research findings and 
reviewing many technology-based learning 
and teaching research, educators and 
teachers need to realize that benefit of 
using technology does not solely determine 
by its effectiveness instead it is the 
pedagogy who does. To make a smooth 
transition from traditional teaching method 
to highly enriched-technological method, 
teachers are obligated to monitor, adapt 
and alter their teaching approaches to 
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achieve the near perfect results. That 
notion implies more additional outside-of-
class work for teachers along with more 
sacrifices in their professions.  

 
5. RESEARCH SUGGESTIONS 

To get more thoroughly accurate 
research finding, the data based on the sex 
of the respondents should be separately 
collected. So, the research could see the 
differences and test whether they are 
significant. Furthermore, group of 
respondents should not only be limited 
within the International College 
ICRMUTK. Different majors such as 
engineers, liberal art, tourism, education, 
business Thai program and textiles are 
available to research.   
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